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A. RECEIVING FILES FROM FIELD SITES 

 

Zipped files received from field sites should be unzipped and organized within the Sueño 

database (\\Rfa01\bwh-sleepepi\projects\src\sueno). It is important that all files received be 

carefully labeled according to the procedure below. Confirm that sites have properly labeled 

all files (original zipped file, Actigraphy file and Daily Sleep Log) with the same subject ID 

and contact occasion. If this is not the case, delete the received files and ask sites to resend 

the zipped file with proper labeling. 

 

1. Receiving Files: Zipped files labeled with a subject ID number will be sent from Field 

Sites to the Reading Center.  

a. Open the folder labeled Sueño > Data > Incoming 

b. New zipped files will appear in the Incoming folder twice daily (noon and 

11:00pm). 

2. Unzipping Files:  

a. Make sure a copy of WinRAR, WinZip or another zipping program has been 

downloaded.  

b. Double click on the zipped file in order to open the file in a zipping program. 

c. Click on the Extract to icon. Click OK. Enter the encryption password sueno321 

and click OK. Unzipped contents should appear in the Incoming folder. 

 

Figure 1. Unzipping Files 

 
 

d. The extracted Actigraphy file and the Daily Sleep Log should be placed in a 

folder labeled with the subject ID and the contact occasion (A or B) and this 

folder should be moved to the ActigraphyRaw folder. The zipped file should be 

moved to the ActigraphyZipFiles folder (see below). 

 

ActigraphyRaw Folder: This folder should contain a folder labeled with the subject ID and 

contact occasion (ex: C6123456A).  

  

file://rfa01/bwh-sleepepi-home/projects/sueno
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Figure 2. Actigraphy Raw Folder 

 
 

Subject ID + Contact Occasion Folder: This folder, within the ActigraphyRaw folder, should 

contain an .AW5 file (Actigraphy file) containing the actogram along with a scanned copy of the 

Daily Sleep Log. 

 

Figure 3. Verifying Actigraphy Folder Contents 
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ActigraphyZipFiles Folder: This folder should contain the original zipped file received. 

 

Figure 4. Verifying Original Zip Files 

 
 

3. Verify Match:  

a. Each subject is given an ID that begins with the capitalized first letter of the site 

name followed by 7 digits (example: C6123456). The first letter should be B, C, 

M, or S (B: Bronx, C: Chicago, M: Miami, S: San Diego). Confirm that the files 

for the actogram and the Daily Sleep Log are labeled with the same subject ID 

and contact occasion. 

b. If files are not in this format (same subject ID and contact occasion), delete files 

and ask the field site to resend files clearly labeled with the same subject ID and 

contact occasion. 

c. If a subject failed to return a Daily Sleep Log or the log was left blank by the 

subject, there should be a blank Daily Sleep Log present. Encourage the Field Site 

staff to enter the participant ID, contact occasion and dates in the allotted portion 

of every page in the Daily Sleep Log. 

d. If there is no Daily Sleep Log present, delete files and contact the field site from 

which the zipped file was sent. Ask the site to resubmit the zipped file with both 

an actogram and a Daily Sleep Log. Do not assume that the absence of a Daily 

Sleep Log means the subject left the log blank. 

 

B. QUALITY CHECK 

 

The aim of this check is to quickly determine whether participants need to be contacted for a 

repeat study. Open the participant’s Actigraphy file and adjust settings in order to determine 

whether the received Actigraphy file is of sufficient quality. Insufficient quality Actigraphy files 

are those that have fewer than 5 days of valid data either because there were fewer than 5 days 

recorded or because there were fewer than 5 included days after considering the exclusion 

criteria below (see B.2.a). A day is defined on the actogram based on the pre-set “Actogram 

Start Hour” under the “Analysis” menu, normally from 12:00:00 pm to 11:59:30 am. If the file is 
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determined to be of insufficient quality, contact the Field Center as soon as possible and follow 

procedures outlines in section B.3. 

 

Note: The Start Hour is set to 12:00 pm except for the few cases when a 12:00 pm start time 

would create a ripple effect, invalidating days that would otherwise be valid because the main 

rest interval extends across 12:00:00 pm (noon). In these cases, assess if setting the start-hour in 

three-hour increments would remedy the situation. In most cases, the situation is remedied by 

setting the start hour to 3 pm, thus defining a day as the time from 3:00:00 pm- 2:59:30 pm. Any 

and all such exceptions are documented in the “Tracking Changes Log” under the “Start Hour 

Exceptions” tab with the Subject ID, Contact Occasion, new Start Hour, and specific reason with 

excluded day(s) that caused the exception.  

 

Figure 5. Verifying/ Setting the Actigraphy Start Hour 
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Figure 6. Actigraphy Start Hour Exceptions: Problem 

 
Figure 7. Actigraphy Start Hour Exceptions: Solution 
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1. Adjust Settings in Actiware: 

a. Open the desired database by opening Respironics Actiware 5 and selecting File 

> Database > Open and search for the .AW5 file labeled with the appropriate 

subject ID and contact occasion. In the Database Viewer (on the left) select the 

subject file (has a picture of a head next to it) with the matching subject ID. 

Double clicking on this file will result in the appearance of a watch icon as well as 

the actual date and time the recording began. The rows beneath the watch icon 

display the data that can be viewed and edited. Select New Analysis. An 

actogram should be displayed in the Actigraphy Viewer. Each row in the 

Actigraphy window displays activity from 12:00:00 pm to 11:59:30 am of the 

next day.  

 

Figure 8. Database Viewer 

 
 

Figure 9. Actigraphy Viewer: 
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b. For ease of viewing, set the Activity Scale Maximum to 100 and set the 

Actogram Length to the number of days with on-wrist data (on the right side of 

screen).  

c. Under Visibility, deselect the colored light signals (red, green, blue) in order to 

get a clearer view of the Activity. Select and deselect the white light signal 

(orange). The white light signal provides useful information on the quantity of 

light. Set the White Light Scale Maximum to 100. 

 

Figure 10. Adjusting Visibility Settings 

 
 

d. Make changes to Properties by selecting Analysis>Edit Analysis Properties 

from the Respironics Actiware main menu. This will open the Edit Analysis 

Properties window. Under the Active Analysis column, make the following 

adjustments: 

i. Set the Wake Threshold Selection to Medium. 

ii. Set the Sleep Interval Detection Algorithm to Immobile Minutes. 

iii. Set Immobile Minutes for Sleep Onset to 5 minutes and for Sleep End 

to 0 minutes.  



MOP: Sueño, Reading Center Procedures 4/20/2014 ver. 3.0  10 

iv. Ensure the actogram Start Hour is set to the default of 12:00 PM (or that 

it meets the exception rule to start at a different time as noted above). 

v. Click on the button labeled Apply and then select OK (see below). 

 

Figure 11. Adjusting Analysis Properties 

 
 

2. Brief Quality Check: 

a. Look over the actogram and confirm: 

i. There are a minimum of 5 days (12:00pm to 11:59am) recorded. 

ii. Out of the 5 days, there are at least 5 days with less than 4 hours of 

off-wrist, no data or data failure. 

iii. No off-wrist, no data or data failure during the beginning, middle or 

end of the sleep interval for the 5 days. 

b. If it is not apparent simply from viewing the actogram whether there are 4 hours 

of off-wrist time within a day, select View>Statistics Table. In the statistics table 

window, select the Daily tab. Under the Off-Wrist column, the total number of 

off-wrist minutes will be displayed. If there are 240 minutes or more of off-wrist 

time for a given day, then the day would be considered to have more than 4 hours 

of off-wrist time. Note that only the off-wrist is displayed using this technique; 

time with no-data and time with data failure cannot be accounted for using this 

technique. 
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Figure 12. Selecting Statistics Table 

 
 

Figure 13. Statistics Table View 

 
 

3. Contacting Sites: If the study is determined to be of sufficient quality (5 or more days 

meet the criteria in B.2.a), GO TO SECTION C. If the study is determined to be of 

insufficient quality (fewer than 5 days meet the criteria in B.2.a), the field site from 

which the Actigraphy file was sent should be immediately told to contact the subject to 

try to obtain another round of Actigraphy if this is the first round of Actigraphy for the 

participant (contact occasion A or 1). Do not contact sites if this is the participant’s 

second round of Actigraphy.  

a. The form entitled Study Failure Form should only be completed for first time 

studies (contact occasion A or 1) that were determined to be of insufficient 

quality. This form should not be completed for repeat studies (contact occasion B 

or 2) regardless of the quality of the study. The first half of the form is to be 

More than 4 hours 

(240 min) off-wrist 
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completed by the Reading Center staff and the second portion is to be completed 

by the Field Site staff. 

i. In the Sueño database \\Rfa01\bwh-sleepepi\projects\src\sueno, select 

Data>Study Fail Form and open the file Study Fail Form. 

ii. Enter today’s date in the Date Failed section. 

iii. Enter the participant’s ID in the ID Number section. 

iv. Enter the scorer’s initials. 

v. Note that only Contact Occasion 1 (first contact) or -1 (confusion) can 

be entered. Contact occasion 2 cannot be selected because this form 

should NOT be completed for those studies. 

vi. Enter the Failure Reason. If the study failed because fewer than 5 days 

were recorded or fewer than 5 days were of sufficient quality, enter 

Fewer than 5 days of valid data. Alternatively, if the study failed 

because data could not be properly retrieved, enter Data corruption/ 

technical failure. For all other reasons, enter Other. If this option is 

selected, make sure to detail the failure reason in the notes section 

below. The Notes section should also be used for providing feedback to 

the field site about ways to eliminate this failure in future studies. 

vii. After the first half of the form has been completed, the next line in the 

form will state To be completed by Field Site Staff. At this point save a 

copy of the form under Data>Failed Studies>Pending. Label the form 

with the participant ID and the contact occasion. Additionally, print a 

copy of this form and place it in the binder labeled Sueño Pending.  

b. Sueño Email Submission: Send the Study Failure Form to field sites immediately 

from the BWH Sueño Sleep Study email account (bwhsueno@partners.org). In 

order to access this account, open Internet Explorer and enter the address: 

https://phsexchweb.partners.org/exchange/bwhsueno@partners.org. In the BWH 

Sueño Sleep Study email account, send an email to the Field Center staff with the 

participant’s partially completed Study Failure Form as an attachment. Field 

Center staff is expected to return the fully completed form to the Reading Center. 

Once the completed form is returned, save the completed version OVER the 

original saved file in Data>Failed Studies>Pending and MOVE the completed 

form from the Pending folder to the Complete folder. Additionally, MOVE the 

incomplete Study Failure form from the Sueño Pending binder to the Sueño field 

site binder (ex: both forms would be placed in the Sueño Site 1 Albert Einstein 

binder in the case of a file received from the Bronx). PRINT a copy of the 

completed Study Failure form and add this form to the Sueño field site binder. 

 

  

file://rfa01/bwh-sleepepi-home/projects/sueno
mailto:bwhsueno@partners.org
https://phsexchweb.partners.org/exchange/%20/bwhsueno@partners.org


MOP: Sueño, Reading Center Procedures 4/20/2014 ver. 3.0  13 

Example of a Quality Actogram: A minimum of 5 days were recorded. Out of the 7 days 

recorded, one of the corresponding days had more than 4 hours of no data time. There were no 

off-wrist, no data or data failure episodes during the beginning, middle or end of the sleep 

intervals that would have prevented confident estimations of sleep interval timing and duration. 

Therefore, 6 days had quality data. 

 

Figure 14. Example of a Quality Actogram

 
 

 

Example of an Insufficient Quality Actogram: A minimum of 5 days were recorded. Out of 

the 7 days recorded, the first day had more than 4 hours of no data. The second day had off-wrist 

time at the end of the sleep interval. Since one of the parameters, the Marker, was pressed after 

the off-wrist episode, the end of the sleep interval as well as the duration could not be determined 

with confidence.  The fourth day had more than 4 hours of off-wrist time. Therefore, out of the 7 

days recorded, only 4 of the days had quality data. Since fewer than 5 days had quality data, a 

repeat trial is desirable. Please see next page for an example of an insufficient quality actogram 

(Figure 15). 

4+ Hours 

of No Data  
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Figure 15. Example of an Insufficient Quality Actogram 

 
 

C. DAILY SLEEP LOG DATA ENTRY  

 

Information from the Daily Sleep Log (Diary) should be entered into the Access file: sueno 

sleep diary.mdb. Entering this data will provide an electronic way to keep track of 

participant logs as well as provide a copy of the data from the original log. It is important to 

realize that the Sleep Log is a subjective recording by the participant of their sleep habits and 

is prone to human error. Keep the participant’s Actiware file open when entering log data in 

order to determine when a participant’s entry does not make sense based on the actigraphy 

recording. In this case, make sure to note that the data entered by the participant does not 

make sense. This will help to minimize the amount of human error present in the log data. 

For more information about what to do when a log entry does not make sense, see entry 

C.1.k. 

 

1. Entering Daily Sleep Log Data:  

a. Select sueno sleep diary.mdb > open. Enter the assigned SQL Login ID and 

Password and click OK.  

 

Figure 16. Login to Sleep Log Data 



MOP: Sueño, Reading Center Procedures 4/20/2014 ver. 3.0  15 

 
 

b. Select the button labeled New in the upper right hand corner in order to start a 

new form. 

c. Confirm that the dates of the Daily Sleep Log entries are consistent with the dates 

displayed on the actogram. Note: the Daily Sleep Log should be offset from the 

actogram by 1 day because the log is completed the morning after. 

d. Do not enter data from Day 0 of the Daily Sleep Log. Enter data starting with 

Day 1 of the log.  

e. The Contact Occasion should be entered as 1 if this is the first time the subject 

has participated, 2 if this is the subject’s second time participating and -1 if it is 

unclear as to the contact occasion.  

f. If the subject did NOT complete a Daily Sleep Log as indicated by receipt of a 

blank Daily Sleep Log, select the button No Data. Selection of this button will 

result in the answer to every question on the form automatically being filled in as 

permanently missing or -9 (see below). In instances where the dates on the diary 

cannot be obtained, enter the dates on the actogram and make a note in the entry 

that this is what you did. 

 

Figure 17. Blank Data Sleep Log 

 
 

g. If specific items on the Daily Sleep Log were left blank by the subject, select -9 

from the drop down menu or type -9.  

h. If it was unclear as to what the subject had intended to record, select confusion or 

-1.  
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i. If the subject did not perform a particular action, select Not Applicable or -8 

indicating that the question being asked is not relevant for the subject. 

j. Certain inputs will result in certain fields automatically becoming filled. For 

example, if a participant entered “no” in response to question 6, then all fields 

for question 6a will automatically be filled in with -8. 

 

Figure 18. Automatic Inputs 

 
 

k. Enter comments in the Form Entry Notes section as needed. Important note: 

unlike the Actigraphy data, the Daily Sleep Log is a subjective recording of the 

participant’s perception of when they went to bed and woke up. This log is prone 

to human error and when an entry does not make sense, use your best judgment 

as to what the participant intended to record. Make a note of the nonsense 

information in the log in this section. For example, if the participant recorded 

that they went to bed at 12 pm and woke up at 7 am, it is likely and can be 

confirmed in the actogram that the participant actually went to bed at 12 am. 12 

am would be entered into the log as the answer to question 1 and this correction 

would be noted in the form entry notes. 

 

2. Daylight Savings: If a watch is worn over the transition to or from daylight savings, the 

Daily Sleep Log entries will differ from the Actigraphy data by 1 hour. It is important to 

make a note of this discrepancy. Please note that watches worn before or after the 

daylight savings transition will not exhibit this 1 hour discrepancy. 

a. For each day following a change to or from daylight savings there will be a 

discrepancy of 1 hour between the Daily Log and the actogram data. This 

discrepancy should be noted in the Form Entry Notes section for EVERY day 

following the daylight savings transition.  

b. The original time entered in the Daily Sleep Log should be entered into Access. 

However, the 1 hour discrepancy should be accounted for when placing sleep 

intervals (see section D). 

3. Saving Daily Sleep Log Data: After the form for a specific day has been completed, 

select the button labeled Submit in the upper right hand corner and the completed form 

will automatically be saved in the Subject Database. Note: It is important that all fields 

are filled in. If fields are left blank, an error message will appear when “Submit” is 

selected. 

 

Figure 19. Error Message for Blank Fields 
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a. Forms should be completed and saved for all 7 days of the Daily Sleep Log 

regardless of whether the subject completed all pages. 

b. In the main window, confirm that all 7 daily log entries are present. 

c. Exit the Sleep Diary Program in Access. 

 

 

D. SETTING ACTIGRAPHY SLEEP INTERVALS 

 

Rest intervals should be manually set in the participant Actigraphy file with the goal of 

capturing when the participant intended to sleep. Sleep intervals correspond to the time the 

Actiware software estimates that the participant was actually sleeping as opposed to lying in 

bed awake. These intervals are automatically generated within rest intervals. Therefore, the 

focus of this chapter is the accurate placement of rest intervals (periods when the participant 

intended to sleep). Placement will be dictated by 4 parameters: the Marker, the Daily Sleep 

Log, the Light Quantity and the Activity. The Marker, the Light Quantity and the Activity are 

recorded in the Actiware program. The Daily Sleep Log file should be referenced alongside 

the participant Actigraphy file. Keep in mind that the Daily Sleep Log is a subjective 

estimate of when the participant remembered they intended to sleep and is more prone to 

human error compared with the Actigraphy parameters. 

 

Important note about Rest Intervals: Each Rest Interval is defined by a start and end time – the 

times the subject began and ended trying to sleep. These start and end times are called the bed 

time and wake time respectively. Note that these times differ from sleep onset and sleep offset, 

which are the times the subject first actually fell asleep and last woke up within the Rest Interval. 

 

There are 4 Parameters that can be used to determine when a person is sleeping: the Marker, the 

Daily Sleep Log, the Light Quantity and the Activity.  

 

 The presence of a Marker, displayed as an upside down dark blue triangle above the Actigraph, 

shows when the participant intended to sleep or wake up. The Marker is pressed in real time and 

therefore tends to be a more accurate estimate of bed/wake time in comparison to the Daily Sleep 

Log. The time when the Marker was pressed by the subject can be viewed on the actogram 

placing the mouse on top of the Marker. A time will appear followed by MRK.  

 

Figure 20. Viewing Marker Time 

 
 

The Daily Sleep Log is completed by the subject for a given day the morning after. The log 

shows the subject’s recalled bed/wake time. These bed time and wake times can be viewed in the 

Daily Sleep Log under questions 1 and 4. Account for the amount of time the participant 

recorded it took them to fall asleep (question 2).  
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A change in the white Light Quantity, displayed as a yellow-orange trace in the actoram, serves 

to indicate bed time and wake time in addition to the Marker and the Log. A sustained decrease 

in the quantity of light may indicate that the lights were turned off thereby serving to indicate 

bed time. A sustained increase in the quantity of light may indicate the lights were turned on 

thereby serving to indicate wake time. Light quantity can be viewed multiple ways. In the main 

actigraphy window, light is shown as a yellow trace. The exact value in lux for every 30 second 

period can be viewed by clicking on the actogram. A caption will appear beneath the area on the 

actogram clicked listing the Light Quantity, l. In the figure below, this value is displayed inside a 

red box. 

 

Figure 21. Light Intensity 

 
 

By deselecting the Activity, shown as a black trace under the Visibility section to the right of the 

actogram, only the light quantity will be displayed on the actogram. 

 

Figure 22. Isolating Light Intensity 

 
 

In order to get a different view of the light data, double click on the actogram on the region 

associated with the interval of interest. A new window entitled “Graph” will pop up. Note that in 

the Graph view the time scale is compressed. Of note, this view typically provides a greater 

visual contrast between the time in a 24 hour period when the light levels are high and the time 

when they are low. Therefore, it tends to be easier to see the transition in light levels between 

sleep and wake in this view (Figure 23). 
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Figure 23. Graph View of Light Intensity 

 
 

In order to determine the time when the lights went off, indicating intent to sleep, find the time 

with the greatest sustained drop in light intensity. For bed time, the light quantity parameter 

would be recorded as the time the light quantity drops to less than 1 lux and remains at this level 

a sustained period of time, usually over 2 hours. If light does not drop to below 1 lux for 

bedtime, choose the time at which light intensity drops to the minimum level recorded that day. 

For wake time, the light parameter would be recorded as the time when the light quantity 

increases to more than 1 lux and remains over 1 lux for a sustained period of time. If there is a 

gradual increase in light intensity associated with wake time, choose the time point with the 

greatest increase/contrast.  

 

Another visual contrast that may aid in interval placement is when light goes from a constant 

value from epoch to epoch to a varying level, which can be an indication that the participant is 

moving their wrist. In some cases, contrast rather than absolute light levels will provide an 

indication of when the participant woke up. 

 

A change in Activity, displayed as a black trace in the actogram, serves to indicate sleep onset 

and sleep offset, NOT bed time and wake time. Thus, a drop-off in activity may indicate sleep 



MOP: Sueño, Reading Center Procedures 4/20/2014 ver. 3.0  20 

onset. Similarly, an increase in activity may indicate sleep offset. Note: because sleep onset and 

NOT bedtime is determined by a drop in activity, it becomes impossible to determine Sleep 

Latency (the time from bed time to sleep onset) if the start of the sleep interval is placed at the 

time activity drops off. 

 

On the main actigraphy window, activity is shown as a black trace. The activity count value for 

every 30 second period can be viewed by clicking on the actogram. A caption will appear 

beneath the area on the region of the actogram clicked listing the light activity count, ac. In the 

figure below, this value is displayed inside a red box. 

 

Figure 24. Activity Count 

 
 

By deselecting White Light, shown as an orange trace under the Visibility section to the right of 

the actogram, only the activity will be displayed on the actogram. 

 

Figure 25. Isolating Activity Count 

 
 

In order to get a different view of activity, double click on the actogram on the region associated 

with the sleep interval of interest. Of note, this view typically provides a greater visual contrast 

between the times when there is a lot of activity and when there is low activity. Therefore, it 

tends to be easier to see the transition in activity levels between sleep and wake in this view. 
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Figure 26. Graph View of Activity Count 

 
 

In order to determine the time the activity level drops likely indicating sleep onset, determine 

where on the actogram there is a transition from mostly black lines (activity) to mostly white 

lines (no activity). At this transition, find the time when the activity count drops to zero (ac=0) 

for a sustained period of time (multiple 30 second intervals where ac=0). The activity time that 

should be recorded is the time of the first ac=0 in the sequence of zero activity counts. In order to 

determine the time the activity level increases, likely indicating the subject woke up, determine 

where there is a transition from mostly white lines (no activity) to mostly black lines (activity). 

At this transition, find the time when the activity count increases from zero for a sustained period 

of time (multiple 30 second intervals where the majority of activity counts are substantially 

greater than zero). The activity time that should be recorded is the time of the first nonzero 

activity count in a series of mostly nonzero activity counts.  

 

In conclusion, a pressed marker, a recorded sleep time and/or a drop in the amount of light serve 

as indicators that the participant tried to fall asleep. Likewise, a pressed marker, a recorded wake 

time and/or an increase in the amount of light serve as indicators that the participant got out of 

bed. In contrast, a drop in activity serves to indicate that a participant fell asleep (onset) whereas 

an increase in activity serves to indicate that the participant woke up (offset). 
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1. Setting Sleep Intervals: Rest intervals should only be set for the main sleep period, 

which is defined as the subject’s longest period of continuous time in bed with the intent 

to sleep. Setting time in bed/out of bed will be based on 4 parameters: the Marker, the 

Daily Sleep Log, the Quantity of Light and the Activity. 

a. In the Actigraphy window select Interval > Clear All Rest Intervals. 

 

Figure 27. Clearing Rest Intervals 

 
 

b. Examine each of the regions on the actogram associated with getting into bed and 

getting out of bed.  

c. Determine which parameters are present for the period of bed time and wake 

time for each main sleep period. 

d. Determine which parameters appear to be reliable indicators of intent to sleep and 

wake up. A reliable parameter is one that unambiguously indicates intent to 

sleep/wake up and seems reasonable considering the other parameters. If a 

parameter is unreliable, do not account for this parameter when setting an interval. 

Note: Light Quantity is often unreliable as a wake time parameter because light 

often gradually increases as the sun rises. Activity is rarely considered unreliable. 

e. Bed time and wake time should be determined by the set of present and reliable 

parameters. If no parameters are present, set a 30-second rest interval starting 

12:00:00 am. If some parameters are present, but none are reliable, set a 30-

second rest interval at the least unreliable parameter. 

f. Using only present and reliable parameters, examine the following situations to 

determine how to place intervals based on your set of parameters. 

 

Important: Interval placement should be based on determining how many parameters are 

consistent with one another. Parameters that fall within 15 minutes of one another are considered 

to be consistent. For example, if the light quantity substantially changes within 15 minutes of the 
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marker, these parameters would be considered to be consistent with one another. Parameters are 

considered to fall within 15 minutes of one another if each of the parameters falls within 15 

minutes of any other parameter(s). Therefore, even if a parameter does not fall within 15 minutes 

of every single other parameter, if it falls within 15 minutes of another parameter that is within 

15 minutes of every other parameter, all of these parameters are considered to fall within 15 

minutes of one another. For example, if the Marker was pressed at 11:20 pm, 11:30 pm was 

recorded in the Daily Sleep Log and the Light Quantity decreased at 11:45 pm, all of these 

parameters are considered to fall within 15 minutes of one another even though there is a 25 

minute difference between the Marker and the Light Quantity parameters. 

 

i. Situation 1: All of the parameters fall within 15 minutes of one 

another. If so, place sleep interval at the time corresponding to the 

highest priority parameter. Follow this order of priority:  

1. Marker 

2. Daily Sleep Log 

3. Light Quantity 

4. Activity 

ii. Situation 2: A single subset has parameters within 15 minutes of one 

another. If so, determine sleep interval time using the subset of 

parameters that fall within 15 minutes of another present and reliable 

parameter. Follow this order of priority: 

1. Marker 

2. Daily Sleep Log 

3. Light Quantity 

4. Activity 

iii. Situation 3: Multiple subsets have parameters within 15 minutes of 

one another. If there is no majority of present and reliable parameters 

that fall within 15 minutes of one another, but rather there are multiple 

sets of parameters, follow the instructions below: 

1. If the Marker and the Daily Sleep Log fall within 15 minutes of 

each other, set the interval at the Marker time. 

2. If the Marker and the Daily Sleep Log are present and reliable, but 

are not within 15 minutes of one another, determine whether a 

change in light falls within 15 minutes of the Marker. If so, set 

interval at the Marker time. Alternatively, if light is within 15 

minutes of the Daily Sleep Log entry time, set interval at the Log 

time. 

iv. Situation 4: None of the parameters fall within 15 minutes of one 

another. Determine whether any of the parameters fall within 30 

minutes of one another.  

1. All or some of the parameters fall within 30 minutes of one 

another. If so, determine interval placement using the same 

reasoning that was used when parameters fell within 15 minutes of 

one another. Refer to situations 1 through 3 above substituting 30 

minutes for 15 minutes. 

2. None of the parameters fall within 30 minutes of one another. 

If all of the parameters are more than 30 minutes apart, set interval 
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based on Activity (the time when Activity visibly decreased or 

increased).  

3. None of the parameters fall within 30 minutes of one another 

and there is no activity drop associated with the interval. If all 

of the parameters are more than 30 minutes apart, but the interval 

cannot be set based on Activity, follow this order of priority: 

a. Marker 

b. Daily Sleep Log 

c. Light Quantity 

 

Figure 28. Setting Rest Intervals Flowchart 

 
 

g. After the placement of the main sleep period has been determined, set the time in 

bed by clicking on the actogram in the desired location. Clicking on the actogram 

will result in the appearance of a pink arrow beneath the activity plot. In order to 

make adjustments to the placement of the arrow, tap the right and left arrow keys. 

This will result in the pink arrow moving to the right or left in 30 second 

intervals.  

h. When the arrow has been placed at the desired start of rest time, type r. This 

action will result in the appearance of a red flag stating Start REST. 



MOP: Sueño, Reading Center Procedures 4/20/2014 ver. 3.0  25 

Figure 29. Starting a Rest Interval

  
 

 

i. Next, when the arrow has been placed at the desired end of rest time type Shift + 

r. This action will result in the appearance of a red flag stating End REST.  

 

Figure 30. Ending a Rest Interval 

 
 

j. In order to set the rest interval, type Ctrl + r. A light blue color should appear 

indicating the presence of a Rest Interval. The appearance of a medium blue 

color indicates the presence of a Sleep Interval (see Interval Legend in the lower 

right hand corner of the Actigraphy window). Note that in some cases the set rest 

interval will appear as mostly or all light blue in color. Sometimes the set rest 

interval will appear as mostly or all medium blue. In either case, this interval is 

still considered to be a rest interval regardless of the relative proportion of light 

versus medium blue color. 

 

Figure 31. Setting a Rest Interval 

 
 

k. Brief Quality Check: determine whether there was any off-wrist, no data or data 

failure that prevented the ability to set intervals confidently. Following this check, 

if there are now fewer than 5 valid days, and the file is for contact occasion 1 or -

1, repeat steps in section B.3.a-b. 

 

2. Setting Nap Intervals: Naps are considered periods of sleep outside the main sleep 

period. Normally, there is one main sleep period per day and the remaining sleep periods 
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are considered naps. Napping can occur during the day or at night. Nap intervals should 

ONLY be set if there is a Marker and/or Daily Sleep Log entry. Nap intervals should 

NOT be set for periods of low activity outside the main sleep period that are not 

associated with a Marker and/or Log entry. 

a. Examine each of the regions on the actogram associated with a Marker and/or 

Daily Sleep Log entry.  

b. Determine which parameters are present and reliable. In many cases, light 

quantity will not be a reliable indicator of napping. Use only present and reliable 

parameters to set nap intervals. 

 

Important: Participants record naps for a given day the following morning. When a participant 

records a nap, they are often estimating when their naps took place many hours later. Therefore, 

estimates of nap times as recorded on the Log tend to be less accurate compared with estimates 

of bed time and wake time. Therefore, a period of low activity within 4 hours of the time 

recorded in the daily sleep log is considered to be associated with the log entry time. Note: do 

not set a nap interval if the Daily Log entry time coincides with a main sleep period and there is 

no drop in activity within 4 hours of the entry that is outside of the main sleep period. Do not set 

a nap interval if the participant indicated in the Log that they took a nap but no nap time was 

recorded and no other supportive evidence for this nap was present making it impossible to 

place a nap interval. Another important note is that when participants take naps in the morning, 

they often record these naps on the wrong day. They record them for the previous day because 

they are filling out their diary the morning of their nap. Use your best judgment in deciding 

which day to classify these naps under.  

 

i. Situation 1: A Marker and/or Diary are present and fall within 15 

minutes of each other or of a significant change in Activity or light. 

Set the nap interval at the time corresponding to the highest priority 

parameter. Follow this order of priority:  

1. Marker 

2. Activity  

3. Light Quantity 

4. Daily Sleep Log 

If the marker was pressed, and any of the remaining three parameters are 

within 15 minutes of the Marker time, set the nap interval start time at 

the Marker time. If only one Marker is present for the nap interval, set 

the nap start or end time (whichever one is not associated with a Marker) 

using the remaining three parameters in the following order: Activity, 

Light, and Diary. 

ii. Situation 2: A Marker and/or Diary are present and associated with 

a significant change in Activity or Light, but only Light and Activity 

fall within 15 minutes of each other. If the decrease in light and 

activity for bed time are within 15 minutes of each other, start the nap 

interval at the time corresponding to the significant change in Activity. 

Likewise for an increase in light and activity at wake time. 

Reminder: parameters are considered to be associated with each other if 

they fall within 4 hours of one another. 

v. Situation 3: A Marker and/or Diary are present and associated with 

a significant change in Activity or light, but no parameters fall 
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within 15 minutes of each other. Determine whether any of the 

parameters fall within 30 minutes of one another.  

1. All or some of the parameters fall within 30 minutes of one 

another. If so, determine interval placement using the same 

reasoning that was used when parameters fell within 15 minutes of 

one another. Refer to situations 1 and 2, substituting 30 minutes for 

15 minutes. 

2. None of the parameters fall within 30 minutes of one another. 

If all of the parameters are more than 30 minutes apart, set interval 

based on Activity (the time when Activity visibly decreased or 

increased).  

3. None of the parameters fall within 30 minutes of one another 

and there is no activity drop associated with the interval. If all 

of the parameters are more than 30 minutes apart, but the interval 

cannot be set based on Activity, follow this order of priority: 

a. Marker 

b. Light Quantity  

c. Daily Sleep Log 

ii. Situation 4: Neither a Marker nor a Daily Sleep Log entry, if 

present, is associated with an unambiguous decrease in the quantity 

of light or a drop in Activity. In this case, set the nap start time at the 

Marker time if the Marker is present. Set the nap end time 30 seconds 

after the nap start time. If the Marker is absent, set the nap start time at 

the time recorded in the Daily Sleep Log. Set the nap end time 30 

seconds after the nap start time.  

 

For further instruction regarding rules for setting the onset of nap intervals, refer to the flow 

diagram in Figure 32 (next page). 
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Figure 32. Setting Nap Intervals Flowchart

 
 

c. Set the start of the nap interval and the end of the nap interval using the same keys 

that were used to set the in/out of bed times (D.1.i-k).  

d. In addition to setting rest intervals in the actogram in order to indicate sleep 

intervals, custom intervals should be placed over nap intervals in addition to rest 

intervals. Every nap should be marked by a rest interval AND a custom interval. 

The custom interval should occur over the identical interval (same start and end 

time) as the rest interval. Marking naps as custom intervals allows the software to 

distinguish sleep time in the main sleep period from sleep time in naps. 

e. After the rest interval has been placed over a nap, move the pink arrow to the 

same time as the start of the rest interval. When the arrow has been placed at this 

time, type c. This action will result in the appearance of a red flag stating Start 

CUSTOM.  

 

Figure 33. Starting a Custom Interval 
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f. Follow the same steps in order to place the pink arrow at the end of the rest 

interval. When the pink arrow has been placed at this time, type Shift + c. This 

action will result in the appearance of a red flag stating End CUSTOM. 

 

Figure 34. Ending a Custom Interval 

 
 

g. In order to set the custom interval, type Ctrl + c. A horizontal blue bar will 

appear above the rest interval previously set. The presence of both the rest 

interval and the custom interval indicates the presence of a nap (a rest interval 

outside the main sleep period). 

 

Figure 35. Setting a Custom Interval 

 
 

h. Brief Quality Check: determine whether there was any off-wrist, no data or data 

failure that prevented confident placement of the nap intervals. Following this 

check, if there are now fewer than 5 valid days, and the file is for contact 

occasion 1 or -1, repeat steps in section B.3.a-b.  

3. Saving Actigraphy Files:  

a. Select Analysis > Save As. 

 

Figure 36. Saving Actigraphy Files- Save As 

 
 

b. Enter the subject ID under Analysis Name and click Save. For example: 

C6123456. 
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Figure 37. Saving Actigraphy Files- Analysis Name 

 
 

4. Printing Actogram: Print this report by selecting File>Print Report. The printed report 

should be placed in the Sueño binder labeled with the field site the participant’s file was 

sent from. For example, if the Actigraphy file was from the Bronx, place the report in the 

binder labeled: Sueño Site 1 Albert Einstein. 

 

E. DOCUMENTING QUALITY  

 

The quality of the received sleep data will be documented using the Actigraphy Quality 

Form. The general purpose of this form is to indicate the level of confidence that the 

intervals placed are an accurate reflection of the participant’s actual sleep habits for the 

time the Actiwatch was worn.  

 

1. Start the Actigraphy Receipt form: 

a. Select RC_bwh.mdb. A window in Microsoft Access will open. 

b. Under Select Study Database, select Sueno: Sueno/HCHS from the dropdown 

menu. 

c. Under Login, enter SQL username/password. Then press the Login to 

Actigraph Data button.  
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Figure 38. Login to Reading Center QS Database 

 
 

d. Select New Receipt from the upper left hand corner. 

e. In the New Actigraph Receipt, enter the Participant ID (first letter of the field 

site + 7 digits). 

 

Figure 39. Entering New Actigraphy Receipt 

 
 

f. Enter the File Start Date, which is the date of the first on-wrist episode. 

Reference the participant’s actogram for this information. 

g. Enter the Date Received, which is the date the file was received at the Reading 

Center. Reference received Diplomat emails. 

h. Enter the Week Ending Date. This value corresponds to the Friday after the 

study was received unless the study was received on a Friday. In this case, enter 

the date the study was received on. 

i. Select the Unit ID from the dropdown menu. The unit ID corresponds to the last 4 

digits of the Actiwatch serial number. The serial number can be located in the 

participant’s printed Actiware Print Report in the upper right hand corner under 

Actiwatch SN. The serial numbers begin with the letter “S” followed by 5 digits. 

Confirm that the last 4 digits are consistent with the origin site of the watch. Enter 
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-9 or missing only if the serial number of the watch cannot be retrieved. Enter -1 

or confusion if there is conflicting data as to what the serial number is.  

j. Enter the Site Number (Site 1: Bronx, Site 2: Chicago, Site 3: Miami, Site 4: San 

Diego, Site 99: Boston). Confirm that the site number is consistent with the unit 

ID. Enter -9 or missing only if the site from which the data was sent is unknown. 

Enter -1 or confusion if there is conflicting data as to the identity of the site from 

which the data was sent. In some instances, watches originally from the Boston 

site will be sent to a different site as temporary loaner watches. In these instances, 

the Unit ID should correspond to the original site (Boston) and the site number 

should correspond to the site the Actigraphy and Daily Sleep Log data was sent 

from. 

2. Save New Actigraph Receipt: click on the Save button in the upper right hand corner of 

the New Actigraph Receipt form. Close this form and return to the main window where 

the participant’s record should be displayed under Select Record. Confirm that the 

record is present. 

3. Complete Quality Form: It is important to complete every field on this form. Make sure 

to select an answer for every dropdown item. The purpose of the quality form is to 

provide a record of the degree of confidence that the sleep intervals manually set in the 

participant actogram correspond to the times the participant actually intended to sleep and 

wake up. 

a. Under Select Record, select the participant’s record. In the Actigraphy Receipt 

Form, do not complete the rest of the receipt. Instead, select the Open QS Form 

Entry button located in the leftmost column. This action will result in opening the 

Actigraphy Quality Form window.  

 

Figure 40. Entering Actigraphy Quality Form

  
 

 

b. Enter the Data Collection Start and Data Collection End Dates based on the 

Actigraphy file. Note: the data collection start date is the date of the first on-wrist 
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episode and the end date is the date of the last on-wrist episode. In order to find 

the date and time of the first on-wrist episode, click on the actogram near the start 

of the first on-wrist time. A pink arrow with a white caption listing the date and 

time will appear beneath the actogram. Adjust the arrow placement by using the 

right and left arrow keys. The time when the first activity count (ac) occurs is the 

first on-wrist episode. Record the date displayed in the white caption as the Data 

Collection Start Date. In order to find the date and time of the last on-wrist 

episode, click on the actogram near the last on-wrist time. Position the pink 

arrow to the last activity count (ac) and record the date displayed in the white 

caption as the Data Collection End Date.  

c. Enter the Data Collection Start and Data Collection End Times based on the 

Actigraphy file. It is important to enter times in MILITARY TIME. Therefore, 

8:00 am would be entered as 0800 and 8:00 pm would be entered as 2000. If these 

times end in “:30” or 30 seconds, do not record the extra 30 seconds on this form. 

Do not round up. Follow the steps in E.3.b to find the exact times of the first and 

last on-wrist episodes. 

d. Enter the Number of days recorded, which corresponds to the number of days 

(12:00:00 pm to 11:59:30 am) with on-wrist data including day 1 onward. For 

details regarding how day 1 is determined, see E.8. 

e. Invalid Days Due to Removals are days when the Actiwatch was off-wrist for 

more than 4 hours and/or during the main sleep period making it impossible to 

confidently estimate the sleep interval time and duration or both. Additionally, if 

there were more than 4 hours of NO DATA for a given day, this would be 

considered an invalid day due to removal. 

f. Invalid Days Due to Data Corruption are days when there was a Data Failure 

for more than 4 hours and/or during the main sleep period making it impossible to 

confidently estimate the sleep interval time or duration or both. 

g. The Number of Days with Valid Data is the number of days recorded minus the 

number of invalid days.  

h. The Daily Sleep Log is considered reliable if it aided in the confidence of the 

placement of the sleep intervals in the actogram. Enter “-9 Permanently missing” 

if the sleep log is blank or otherwise missing. Enter “-1 Confusion” if the log is 

unclear. 

4. In/Out of Bed Grades: Grades are assigned to both the Time in Bed and Time Out of 

Bed separately. The grade assigned to the Time in Bed for a given sleep interval should 

not influence the grade assigned to the Out of Bed Time and vice versa. The Time in Bed/ 

Out of Bed should be filled in as a grade ranging from 0 to 3. This grade is a measure of 

the level of confidence that the time the sleep interval was set matches the actual time 

that the participant intended to sleep. A grade of 1 or unreliable indicates that the time set 

was a guess/approximation. In contrast, a grade of 3 or mostly reliable indicates that the 

interval set is likely the actual time the participant intended to sleep. 

a. A grade of 3 or Mostly Reliable is assigned when it is likely that the time the 

sleep interval was set corresponds to the actual time the participant intended to 

sleep. Most of the present and reliable parameters indicate that sleep occurred at 

the time the interval was set with only minor inconsistencies. Conversely, it seems 

unlikely there is an alternative sleep time. 

b. A grade of 2 or Somewhat Reliable is assigned when it is probable that the time 

the interval was set corresponds to the actual time the participant intended to 



MOP: Sueño, Reading Center Procedures 4/20/2014 ver. 3.0  34 

sleep, but there is also a reasonable alternative time at which the sleep interval 

could have been placed.   

c. A grade of 1 or Unreliable is assigned when the time the interval was set is at 

best a guess or approximation of the actual time the participant intended to sleep. 

In most cases, there are major inconsistencies between parameters preventing a 

robust prediction of the time sleep actually occurred. 

d. A grade of 0 or No Evidence of Sleep is assigned when there is no indication that 

the participant intended to sleep on a given day. This grade is typically assigned 

when there is a brief on-wrist episode on the last day the participant wore the 

watch. For example, if the participant permanently took their watch off at 2:00 

pm, there would be two hours (12:00:00 pm to 2:00:00 pm) of on-wrist data for 

the last day the watch was worn. If there was no evidence that sleep occurred 

over the two hours the watch was worn, the Time in Bed and Time Out of Bed 

grades for this day would receive a grade of 0. 

e. A grade of -1 or Confusion is assigned when some or all of the parameters are 

missing due to invalid, excluded, and/or off-wrist data. This grade is typically 

assigned when there is an off-wrist episode during the in-bed or out-bed transition 

or between any of the four parameters at either transition. For example, if the 

participant marked a bed-time of 11:00 pm on the Sleep Log, took the watch off 

between 11:15 pm-11:17pm, and then pressed the marker and went to bed at 

11:20, the transition will be at 11:20 pm, but the In-bed score will receive a grade 

of -1. 

5. In/Out of Bed Parameters: In addition to entering a grade for each In/Out of Bed 

episode, the parameter (Marker, Diary, Light Quantity, Activity) that was used to place 

the In or Out of Bed interval should also be indicated. Only the parameter that had the 

exact same time as the time entered for the interval placement should be entered as “1” or 

“Checked” in the Quality Assessment Form. Therefore, a single parameter should be 

checked for each of the In/Out of Bed episodes per day. All other parameters listed 

should be filled in as “0” or “Not Checked.” If a grade of “0” was assigned, enter “-8” for 

all parameters.  

6. Napping Grades: The grade assigned in response to the question “did napping occur?” 

for a given day should be based on how confident the scorer is that naps actually took 

place. The grades assigned range from 0 to 3. Reference both the subject’s Actigraphy 

file as well as Daily Sleep Log when assigning a grade. The napping grade assigned 

should be based on ALL of the naps taken for a given day. Important: the grade 

assigned should be based on the grade given to the LEAST reliable nap. Remember that 

any periods of low activity that are not associated with a Marker and/or Daily Sleep Log 

should not be counted as naps.  

a. A grade of 3 or Mostly Reliable is assigned when all of the naps for a given day 

reported by the participant in the form of Diary and/or Marker entries are likely to 

have occurred based on associated distinct drops in activity. 

b. A grade of 2 or Somewhat Reliable is assigned when there is some evidence that 

the least reliable nap reported by the participant occurred. All Marker and Log 

entries should be associated with some supportive evidence that the least reliable 

nap occurred such as a drop in the quantity of light or a brief drop in activity.  

c. A grade of 1 or Unreliable is assigned when the least reliable nap reported by the 

participant did not have an associated drop in light and/or activity or it seems very 
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unlikely this nap actually occurred. A napping grade of 1 should be assigned to 

days where default 30 second nap intervals are present.  

d. A grade of 0 or No Evidence of Sleep is assigned when there is no Daily Log 

entry or Marker indicating the presence of naps for a given day. 

e. A grade of -1 or Flag/Confusion should be assigned when there is no way to 

determine where a default 30 second nap interval should be placed. This can 

occur if the nap recorded by the participant overlapped with a main sleep period 

or if the participant recorded the nap as having taken place when the device was 

off-wrist. Alternatively, if the only evidence the participant took a nap for a given 

day is in the form of “yes” in response to the Daily Sleep Log question “during 

the day yesterday, did you take a nap or fall asleep for more than 5 minutes?” but 

the actual nap time was not entered and there was no other conclusive evidence, 

then it would be appropriate to assign this grade. If any of the naps for a given day 

received the grade of -1, the grade assigned for the entire day should be -1.  

7. Napping Parameters: Nap intervals can only be set if there was a Marker and/or a Daily 

Sleep Log entry indicating the presence of a nap. Check the parameter(s) that served as 

evidence that napping occurred (Marker, Daily Log or both).  If a grade of “0” was 

assigned, enter “-8” for all parameters. If there are multiple naps on a given day, check 

the parameter(s) that were used to set all nap intervals. For example, if the Marker was 

used as evidence of the first nap interval and the Diary was used as evidence of the 

second nap interval, both the Marker and the Diary should be checked off in the Quality 

Assessment form for that day. 

8. Entering Grades and Parameters Properly: 

a. The day entered as Day 1 in the Actigraphy Quality form should satisfy the 

following conditions: 

i. Day 1 recorded in the Actigraphy Quality form should always match day 1 

in the Daily Sleep Log. Note: the date of day 1 in the log will be off by one 

day compared with the date on the actogram because participants 

complete the log the morning after. 

ii. The date of day 1 in the Actigraphy Quality form should always match the 

Data Collection Start Date. The data collection start date is defined as 

the date of the first on-wrist episode. For instructions as to how to find 

this date, see E.3.b. Do not simply record the date listed to the left of the 

actogram for the day on-wrist begins as the data collection start date. 

Instead, click on the actogram and move the pink arrow to the start of first 

on wrist. 

iii. Day 1 in the Actigraphy Quality form may or may not match the day listed 

as day 1 directly to the left of the actogram.  

 

For additional information on how to designate Day 1 in the Actigraphy Quality form, refer to 

the following examples: 

 

Determining day 1 when first on-wrist episode is at or after the preset start time (in most 

cases 12:00:00 pm): the day the actogram lists as day 1 should match day 1 in the Daily Sleep 

Log. This is also the same day that should be entered into the Actigraphy Quality Form as day 

1. The date of the first on-wrist episode (data collection start date) is the same date as that of 

day 1 in the Actigraphy Quality Form. 
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Figure 41. Determining Day 1 with Data at or after Pre-set Start Time 

 
Determining day 1 when first on-wrist episode is before the preset start time: The day the 

actogram lists as day 1 is NOT the same as day 1 in the Daily Sleep Log. The day that should be 

entered into the Actigraphy Quality Form as day 1 should match day 1 in the Daily Sleep Log. 

The date of the first on-wrist episode (data collection start date) is the same date as that of day 

1 in the Actigraphy Quality Form. Note: on the actogram, the first on-wrist episode will appear 

to be listed on a separate day and date compared with day 1 in the Actigraphy Quality form. By 

actually clicking on the region of the actogram associated with the first on-wrist episode and 

moving the pink arrow to the first on-wrist episode, the white caption that appears under the 

arrow will list the same date for the first on-wrist episode (data collection start date) as the date 

for day 1 in the Actigraphy Quality Form. 

 

Figure 42. Determining Day 1 with Data before Pre-set Start Time 

 
 

b. Entering all Grades and Parameters: Grades should be entered in the leftmost 

field in the Time in Bed, Time Out of Bed and Napping columns. Parameters 

should be checked in the rightmost field in all three columns. If a parameter was 

not checked, select “0” or “unchecked” in the dropdown menu for this parameter 
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rather than leaving the field blank. If a grade of zero was assigned, all of the 

parameters corresponding to this grade should be filled in as “-8” or “Not 

Applicable.” Make sure that every field of this form is complete. If there are 

fewer than 9 days of on-wrist data, enter a grade of “-8” for all fields for the 

remaining rows. Figure 43 (below) shows a blank version of the Actigraphy 

Quality Form. 

 

Figure 43. Entering Grades and Parameters Used in Quality Form 

 
 

9. Determining How Many Days of Valid Data: Enter data for this section in the table 

below on the Actigraphy Quality Form: 
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Figure 44. Determining the Number of Valid Days 

 
 

a. Fewer than 4 hours of off-wrist time or data failure: This value should be the 

sum total of all of the off-wrist, no data and data failure time for a given day. Off-

wrist intervals are indicated by dark blue bands (excluded intervals). Note that a 

day starts at 12:00:00pm and ends at 11:59:30am. Check “yes” if there were fewer 

than 4 hours or 240 minutes of off-wrist time, no data and data failure 

cumulatively. Check “no” if there were 4 or more hours of off-wrist time, no data 

and data failure combined for a given day. For further instruction, see B.2.b. 

b. No off-wrist time or data failure during the sleep interval: If there was no off-

wrist time or data failure during the beginning, middle or end of sleep (including 

all naps), check “yes.” If dark blue bands (excluded intervals) or grayed regions 

of no data or data failure are present at the beginning, middle or end of sleep 

(including all naps), check “no.” 

c. At least 5 days of valid data: Initially determine how many main rest intervals 

are present. If there are fewer than five, check “no.” Then determine how many 

days had no checked for the question “Fewer than 4 hours of off-wrist time or 

data failure?” and/or the question “No off-wrist time or data failure during the 

sleep interval?” Days that had “no” as inputs for either or both question(s) are 

considered to be invalid. Determine how many valid days remain. If there are 

fewer than 5, check “no” for this question. If there are still 5 or more valid days, 

check “yes.” If “no” was selected, make sure that a Study Failure Form has been 

sent to the original field site. Additionally, make sure that the answer to this 

question is consistent with the Number of Days with Valid Data previously 

entered.  

 

10. Study Comments: Enter comments as needed. Enter “-8” or “Not Applicable” if no 

comments are necessary. 
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Figure 45. Study Comments Field 

 
 

11. Saving Quality Form: After all fields have been completed in the Actigraphy Quality 

Form, click on the Save button in the upper right hand corner.  

12. Moving Files in the Sueño Database: Move the folder labeled with the subject ID and 

contact occasion that contains the Actiware file, the Daily Sleep Log and the Quality 

Assessment form from the ActigraphyRaw folder to the ActigraphyScored folder. 

Make sure the folder labeled with the subject ID and contact occasion is no longer in the 

ActigraphyRaw folder. See below: 

 

ActigraphyScored Folder: This folder should contain a folder labeled with the subject ID and 

contact occasion (ex: B1111111A). 

 

Figure 46. Labeling of Scored Actigraphy Folder

 
 

Subject ID + Contact Occasion Folder: This folder should contain the subject’s Actigraphy 

file, Daily Sleep Log and the completed Quality Assessment form. This folder should be saved in 

the ActigraphyScored folder. 

 

Figure 47. Verifying Contents of Scored Actigraphy Folder
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F. CREATING “NO NAPS” ACTIGRAM 

 

The modified “no naps” actogram is created so that there is an actogram only containing 

valid main sleep intervals. The original file containing naps provides a record of all of the 

data present in the file including naps, whereas the “no naps” file provides a record of 

only the valid main sleep periods. Both of these files will be useful in terms of statistical 

analysis. 

 

1. Open Participant Actogram: In the actogram window, open the saved Actiware file for 

the subject by going to the Database Viewer and selecting the actogram labeled with the 

subject ID instead of New Analysis. 

2. Remove Naps: Click on each nap interval and press the Delete key. Successful removal 

will be indicated by the disappearance of the rest and custom intervals. Alternatively, 

right click on the rest interval and select Clear Interval. Then right click on the custom 

interval and select Clear Interval as well. 

3. Set Default Intervals: Every day must have a rest interval. For days lacking rest 

intervals, set a rest interval from 1:00:00 pm to 1:00:30 pm for these days. If there was 

off-wrist at this time, select an alternative location to place the default interval. Note: 

days begin at 12:00:00 pm and end at 11:59:30 am.  

4. Set Excluded Intervals: For main sleep periods (not naps) where the duration of the rest 

interval is unclear, exclude the entire day (12:00:00 pm to 11:59:30 am). Example: when 

the subject had the Actiwatch off-wrist during the time they went to bed (see below). 

 

Figure 48. Excluding Invalid Day Due to Unclear Sleep Duration

 
 

Important: The exclusion criteria are not the same as the criteria for determining whether an 

actogram is of sufficient quality (B.2.a). Days should only be excluded when there is off-wrist 

time or data failure during the beginning, middle or end of main sleep periods, making it 

impossible to determine the duration of sleep periods. If there is off-wrist time or data failure in a 

nap, the entire day should not be excluded on this basis alone. 

a. Position the pink arrow at the Start Hour, normally 12:00:00pm, of the day 

containing the unclear rest interval and type e. This action will result in the 

appearance of a red flag stating Start EXCLUDED.  
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Figure 49. Starting Excluded Interval 

 
 

b. Position the arrow the end of the actigraphy day, (in most cases 11:59:30 am), and 

type Shift + e. This action will result in the appearance of a red flag stating End 

EXCLUDED.  

 

Figure 50. Ending Excluded Interval 

 
 

c. Set the Exclusion interval by typing Ctrl + e. A dark blue band should appear 

indicating the presence of an Excluded interval (see Interval Legend). Make sure 

to delete all rest and custom intervals for the excluded day. Note: if there is an 

excluded interval already present, a message will appear asking to combine 

intervals. Select yes 

 

Figure 51. Combining Excluded Intervals 

 
The entire day from Start Hour to End Time, should be marked as excluded (dark blue). 

Important: If a sleep period is considered invalid and extends past 11:59:30 am, create a 24-

hour excluded interval that includes the invalid sleep period portion after 11:59:30 am. 

 

Figure 52. Setting Excluded Interval 

 
 

5. Saving “No Naps” Actogram: The modified actogram should be saved as subject ID + 

nonaps in the Actigraphy file. Select Analysis>Save As. Do not save over the original 

file with naps included labeled with just the subject ID.  
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Important note: even if no modifications were necessary, save a second copy of the actogram 

following the “no naps” naming system. 

 

6. Confirming Sleep Intervals: Check that the intervals were set correctly by selecting 

View > Statistics Table > OK. Under the Rest tab, look up and down intervals and 

confirm that the number of rest intervals is consistent with the number of main sleep 

periods. 

 

Figure 53. Selecting Statistics Table View 

 
 

Figure 54. Statistics Table 

 
 

G. EXPORTING ACTIGRAPHY FILES  

 

Both the original file containing naps marked with custom intervals labeled with the 

subject ID and the “no naps” file labeled with the subject ID + nonaps should be 

exported as .csv files. The original file containing naps marked with custom intervals will 

be saved in the Naps folder and the “no naps” file will be saved in the No Naps folder. 

 

1. Confirming Statistics: 

a. For the newly saved actogram file labeled with the subject ID + nonaps, select 

Tools > Options. 
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Figure 55. Selecting Statistics Options View 

 
 

b.  In the Statistics tab, confirm that all items are selected, except Enhanced Sleep 

Statistics.  

 

Figure 56. Confirming Statistics Options 
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c. In the Export tab, confirm that all items are selected. Close the Options window.  

 

Figure 57. Confirming Statistics Export 

 
 

2. Exporting Actogram Files: 

a. In the main Actiware window, select the Export icon (a red horizontal arrow on 

top of a white page). 

 

Figure 58. Actigraphy Export Icon
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b. A reminder message will appear. Select OK. 

Figure 59. Actigraphy Export Reminder 

 
 

c. Save the actogram file in the NoNaps folder under the folder 

Actigraphy_sasReports. Label the .csv file with the subject ID + contact 

occasion + nonaps. 

 

Figure 60. Actigraphy Export NoNaps File 

 
 

d. IMPORTANT: Repeat steps G.1.a- 2.b for the original actogram file with naps 

included labeled with only the subject ID. 

e. SAVE the original actogram file in the Naps folder under the folder 

Actigraphy_sasReports. Label the .csv file with the subject ID + contact 

occasion. 
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Figure 61. Actigraphy Export Naps File 

 
 

Both the original and the new version of the actogram should be exported as a .csv file. These 

files should be saved in the Actigraphy_sasReports folder. The original version of the actogram 

should be saved in the Naps folder and the new version of the actogram should be saved in the 

NoNaps folder. 

 

Figure 62. Actigraphy SAS Report Folders 
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H. READING CENTER DATABASE ENTRY  

 

Actigraphy data will be entered into this database so that there is a catalog of the received 

files. The first part of the receipt should have been completed prior to entering data into 

the Actigraphy Quality Form (see E.1-2). It is important to have completed the 

Actigraphy Quality Form prior to completing this receipt. 

 

1. Complete Actigraph Receipt Form:  
a. Inside the Reading Center Database: RC_bwh.mdb, select the participant’s file 

listed under Select Record.  

b. In the Actigraphy Receipt Form that had already been partially completed, enter 

the Contact Occasion. If it is unclear as to the contact occasion, enter “-1.” 

 

Figure 63. Entering the Actigraphy Receipt Form 

 
 

c. Enter whether the study is invalid or valid. An invalid study would be one where 

there were fewer than 5 days of valid data. Refer to the completed Actigraphy 

Quality Form for this information. 

d. Failure Reason: If Valid was entered, the Failure Reason field will auto fill as “-

8” or “Not Applicable.” If Invalid was entered, select the Failure Reason from the 

dropdown menu:  

i. Contact Occasion 1 or -1: Reference the Study Failure Form in order to 

obtain this information. If a Study Failure form is absent for the 

participant, refer to the Actigraphy Quality Form. Select the failure 

reason from the dropdown menu. 

ii. Contact Occasion 2: A Study Failure Form should NOT be present for 

this occasion. Reference the Actigraphy Quality Form in order to obtain 

this information. 

iii. Select -8 or Not Applicable only if the failure reason cannot be 

determined. 

e. Participant Status: The purpose of this field is to determine whether a repeat 

trial will take place. If Valid was entered, the Participant Status field will auto fill 
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as “-8” or “Not Applicable.” If Invalid was entered, select the Participant Status 

from the dropdown menu: 

i.  Contact Occasion 1 or -1: Reference the completed Study Failure 

Form in order to obtain this information. If the field site has not yet 

returned a completed version of the Study Failure Form with the 

Participant Status data entered, select “8” or “Pending” from the 

dropdown menu. When the completed Study Failure Form is returned to 

the Reading Center, change the Participant Status field referencing this 

form. If the site has clearly communicated that they are unwilling or 

unable to return a completed version of the Study Failure Form, enter “9” 

or “Missing”. 

ii. Contact Occasion 2: A Study Failure Form should NOT be present for 

this occasion. Always select -8 or Not Applicable for the Participant 

Status when it is the second contact occasion and the study was invalid. 

f. In the Sleep Journal Received field, enter whether the Daily Sleep Log was 

received. Select from the following dropdown options: 

i. Enter “-1” or “confusion/flag” if it is unclear whether there is a journal 

present for the participant that has the same contact occasion as the 

Actigraphy data.  

ii. Enter “-9” or “missing” if a sleep journal was never received from the 

field site. 

iii. Enter “0” or “no” if a blank sleep journal was received from the field site. 

iv. Enter “1” or “yes” if a sleep journal was received that had some amount of 

data entered by the participant. 

g. For the # of Good Days field, enter the number of days that were considered to be 

valid based on the Actigraphy Quality Form. Under Week days, enter the 

number of days between and including Sunday and Thursday that were 

considered valid. Under Weekend days, enter the number of days that are Fridays 

or Saturdays that were considered valid. Refer to the Actigraphy Quality Form 

and the Actigraphy file for these values. 

h. Enter Comments as needed.  

 

2. Save Completed Actigraphy Form: click on the Save button in the upper right hand 

corner of the Actigraphy Receipt form. Click on the Close button in the upper right hand 

corner of the form, which results in automatically returning to the main window where 

the participant’s record should be displayed under Select Record. Confirm that the 

record is present. 


